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Foreword 

This manual is written for the data acquisition, analysis, 
and presentation software version V2.3x for Kistler 
Dynamometers. We think the Dynoware package will be 
easy to learn and use, yet powerful enough for your 
requirements. 
 
Information in this document is subject to change without 
notice. Kistler reserves the right to change or improve its 
products and make changes in the content without 
obligation to notify any person or organization of such 
changes or improvements. 
 
© 2001, 2002 Kistler Instrumente AG. All rights reserved. 
Except as expressly provided herein, no part of this manual 
may be reproduced for any purpose without the express 
prior written consent of Kistler Instrumente AG. 
 
 
 
Kistler Instrumente AG 
Postfach 
CH-8408 Winterthur 
Schweiz 
Tel. +41 52-224 11 11  
Fax +41 52-224 14 14 
info@kistler.com 
www.kistler.com 
 
 
 
Your competent distributor: 
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1. Introduction 

We thank you for choosing a Kistler quality product. Please 
take the time to thoroughly read this instruction manual. It 
will help you with the installation, maintenance, and use of 
the Dynoware system. 
 
Dynoware is an easy-to-use data acquisition and manipula-
tion program. The typical Windows controls apply to the 
graphs and dialog boxes in Dynoware. This section will 
give you a quick overview of the capabilities of Dynoware. 
 
The menu bar is your access to all areas of Dynoware. It is 
divided into sections covering specific functions such as file 
handling, data acquisition configuration, hardware 
configuration, data viewing, window control, and 
obtaining help. In addition to the menu bar, there is a 
toolbar similar to those found in major word processing 
and spreadsheet programs. The toolbar consists of icons 
that execute a specific function when clicked.  
 
The user has full control over data acquisition. Sampling 
rate and length of trials, as well as amplifier range and 
trigger options are all easily accessible. The units of data 
acquisition can be customized to the desired physical data 
being measured. 
 
The graphs are designed to be easy to read, and can be 
fully customized. The number of graphs to view is flexible, 
along with default parameters so each trial is readily 
viewed in a format that is most useful to the user. 
 
If you have questions at any time while in Dynoware, 
simply press the F1 key and the Dynoware on-line help 
window appears. Help is also available from the menu bar. 
 
Kistler offers a wide range of products for use in measuring 
technology: 
§ Quartz crystal sensors for force, torque, strain, 

pressure, acceleration, shock, vibration and acoustic-
emission 

§ Piezoresistive pressure sensors and transmitters 
§ Signal conditioners, indicators and calibrators 
§ Electronic control and monitoring systems as well as 

application-specific software for measuring technology 
 
Kistler also develops and produces measuring solutions for 
the application fields engines, vehicles, manufacturing, 
plastics and biomechanics. 
 
Our product and application brochures will provide you 
with an overview of our product range. Detailed data 
sheets are available for almost all products. 
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1.1 Getting Software Help 

Dynoware software takes advantage of 
the HTML on-line help system to offer you 
quick assistance at the touch of a button. 
You will need Microsoft Internet Explorer 
Version 5.01 of newer, or comparable 
browser to view the HTML help. To 
receive immediate help from wherever you 
are in Dynoware, press the F1 key and a 
window will pop up with specific advice 
about where you currently are in the 
software. 
Help is also accessible through the menu 
bar found at the top of the screen. 
 
If you need additional help beyond what 
can be found either on-line or in this 
manual, please contact Kistler's extensive 
support organization. 

 

Figure 1.1: Help is available by pressing the F1 key or by 
selecting the Help from the menu 

1.2 Customer Support 

The worldwide Kistler service organization is available for 
any special questions or problems that you may have after 
your careful study of these instructions. Note, refer to 
sections 1.3 through 1.6 for general policies on customer 
support. Before you call, please be ready to fully explain 
your problem. If you are experiencing a problem with 
Dynoware software, please try to duplicate the problem 
and take a snapshot of the screen by pressing the "print 
screen" button. This copies the screen to the clipboard so 
that it can be pasted into a word processing program and 
printed. You can fax or mail this picture to Kistler, or e-mail 
the data file to us via Internet. 
 
Our Internet e-mail address for Dynoware support is: 
force@kistler.com 

1.3 Service and Assistance 

The customer is responsible for proper Dynoware 

installation and operation. Dynoware must be installed as 
per instructions provided in sections 4 and 5. If modifi-
cations to these instructions are necessary for a particular 
purchaser site, Kistler recommends the purchaser contact a 
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Kistler representative for input and advise regarding these 
changes. 
 
Installation problems and subsequent system performance 
difficulties can be adverted by timely communication. 
Often, questions can be answered through email or 
telephone conversations. The purchaser is encouraged to 
email or call the appropriate Kistler organization in the 
event of such questions. 
 
We welcome comments and suggestions for future 
features and enhancements. Please email all suggestions to 
force@kistler.com  

1.4 License Agreement 

Please refer to the Software License Agreement packet 
containing your Dynoware software and to the license 
presented during installation. This packet thoroughly 
details the Software License Agreement.  
 
Dynoware is protected by the copyright laws that pertain 
to computer software. It is illegal to make copies of the 
software or documentation except for backup purposes. It 
is illegal to give software or documentation to another 
person or institution. The software contains trade secrets 
and in order to protect them you may not decompile, 
reverse engineer, disassemble, or otherwise reduce the 
software to human-perceivable form. You may not modify, 
adapt, translate, rent, lease, or create derivative works 
based upon this software or documentation. 

 
You may permanently transfer the software to another 
user provided you notify Kistler in advance, transfer the 
documentation and all disks, and notify the new user of 
the terms and conditions of the license agreement. 

1.5 Warranty 

Kistler warrants Dynoware to be free from defects in 
material and workmanship as stated in the software license 
agreement. It is warranted only under normal use and 
service. The period of warranty is twelve (12) months from 
date of shipment. 
 
When returning items under warranty, said equipment 
shall be returned to Kistler Instruments prepaid. Full details 
relative to the claim or malfunction shall accompany the 
shipment. No action will be taken until these details are 
received. Please contact Kistler or your Kistler 



Dynoware Type 2825A1-2 

Page 8  002-195Ae-06.02 (B19.2825Ae) 
 

representative for a Return Authorization Number before 
returning goods. 
 
Settlement will be made at Kistler’s discretion, either 
through repair or replacement of the item in question or 
through issuance of full credit. Damage occurring through 
misuse or mishandling, will not be covered by this 
warranty. 
 
This warranty is in lieu of all warranties expressed or 
implied, and of all obligations or liabilities on the part of 
Kistler Instruments for damages following the use or 
misuse of items supplied. Any unauthorized disassembly or 
attempt at repair shall void this warranty. 
 
No agent or representative is authorized to assume for the 
Corporation any liability except as set forth within this 
warranty document. 

1.6 Claims 

Claims relating to goods delivered must be made within 14 
days of receipt of goods. After fault determination by 
Kistler, settlement will be made either by the carrier, 
insurer, or Kistler. Means will be through replacement, 
repair or credit. 
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2. Important Information 

Please practice common sense safety rules at all times. 

2.1 For your Safety  

Prior to any installation and repair work or cable changes, 
you must disconnect all power sources from the instru-
ments. 
 
Observe all local safety regulations concerning the hand-
ling of line-powered electrical and electronic equipment. 
 
When it must be assumed that safe operation is no longer 
possible, the computer, charge amplifier, etc. must be 
taken out of operation and secured against unintentional 
use. 
 
Whenever opening covers or removing parts, except where 
this can be done by hand, use caution where parts under 
hazardous voltage are exposed. 

2.2 Warning 

Any breakage of the ground conductor inside or outside 
the instruments, or loosening of the ground conductor 
connection may render the instrument dangerous. 
 
The power plug must be inserted in to a socket with a 
ground connector. The protection must not be nullified by 
an extension line lacking a protective ground connector. 
 
When changing the signal conditioner fuses, only the 
standard type with the specified amperage rating must be 
used. Use of repaired fuses or short-circuiting the fuse 
holder is expressly forbidden. 

2.3 How To Use This Manual 

Whether you are a novice at computers or a long time 
programming expert, you will be pleased to learn how 
quickly and easily you will become familiar with the 
operation of Dynoware. This manual will take you through 
the installation and setup of the Dynoware software, and a 
complete reference to all of the features of this software. 
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If you are eager to begin operation of Dynoware we 
recommend section 5 of this manual for a quick start 
guide. Remember that on-line help is always available by 
pressing the F1 key from anywhere in the software. 
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3. Description of Dynoware 

3.1 General 

Dynoware is a general-purpose data 
acquisition and display software pack-
age suitable for cutting force and 
general dynamometer applications. It is 
designed to combine the performance 
of the proven line of Kistler quartz 
dynamometers with modern computer 
technology. Dynoware lets you quickly 
setup, record, and display reaction for-
ces and moments. 
 
All components have been included 
with the system (i.e., software, cables, 
and A/D board). If a computer is in-
cluded with your system, the Dynoware 
software is already installed on it and 
you can skip the software installation 
portion of this manual. 
 
 
 
 
 

Figure 3.1: The Dynoware splash screen appears for a few seconds when the application starts 

 
The Dynoware system can consist of many components, 
each specific to the user’s application. These include: 
§ Dynamometer 
§ Charge amplifier 
§ Measurement Computing Inc. DAS-1602 or 

compatible A/D board 
§ Dynoware software and manual 
§ All necessary cabling. 
 
A computer can be purchased with the software and A/D 
board pre-configured. 

3.2 System Requirements 

In order to effectively use Dynoware software you will 
need to have an IBM-compatible personal computer that 
meets or exceeds the following recommendation. 
Dynoware may not run properly if these computer 
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specifications are not met. The overall system performance 
is dependent on the selection of hardware. 
 
Recommended Computer Specifications: 
§ IBM PC Pentium II 500 MHz or 100% compatible 

computer 
§ 32 Megabytes RAM minimum, 64 Megabytes 

recommended 
§ Hard Disk Drive with at least 100 Megabytes available 

for data storage and software installation 
§ CD-ROM 
§ Microsoft Windows 95, 98, NT 4.0, 2000 or ME 
§ 1 available expansion slot for the data acquisition 

board. ISA, PCI, and type II PCMCIA bus versions of 
the A/D boards are available 

§ Microsoft compatible mouse 
§ A color printer is recommended for creating hard 

copies of graphs 
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4. Installing Software 

This chapter will show you how to install the data 
acquisition board, the Dynoware software, configure the 
data acquisition hardware, as well as hook up the cable 
from the A/D board to the signal conditioner. 

4.1 Dynoware Software Installation 

Dynoware software consists of one CD-ROM media disk 
containing an automatic installation procedure. If a com-
puter was purchased as part of the Dynoware system, then 
the software is already installed and the enclosed 
Dynoware CD-ROM should be stored in a safe place as a 
backup. To install Dynoware perform the following proce-
dure:  
 
1. Insert Dynoware Disk into your CD-ROM drive.  
2. (If your CD-ROM is setup to auto play you can skip 

this step) From the Start menu, choose Run, In the 
dialog box, type “d\:readme” (without the quotes) 
substitute your CD-ROM drive letter for “d” above, 
Choose OK. 

3. The “readme.exe” program presents general inform-
ation on installing Dynoware. We recommend reading 
this information prior continuation. Select the <click 
here> option under the desired language. 

Figure 4.1: Running the setup program 

 

 

Installation Note: 
You may run the setup program directly by entering 
"d:\setup" from the Start → Run windows dialog box. 

 
The main Dynoware installation screen will present you 
with links to the three installable components: The 
Dynoware main application, the Runtime License driver 
installation, and the Data Acquisition board driver 
installation. 



Dynoware Type 2825A1-2 

Page 14  002-195Ae-06.02 (B19.2825Ae) 
 

 
Select Dynoware installation and follow 
the instructions to review the license 
agreement and to install the main 
application. 
 
After Dynoware is installed, the main 
installation dialog box will reappear (it 
may take a few seconds). Select 
Runtime License driver installation and 
follow the instructions to install the 
runtime license (HASP key). If you do 
not install the Runtime License, 
Dynoware will operate in only in a 
feature limited demonstration mode. 

Figure 4.2: Main Installation screen 

Next, select the Data acquisition board driver installation to 
install the Measurement Computing Inc. drivers for the 
data acquisition board. Follow the instructions on screen to 
install the driver. At the end you will be prompted to 
reboot the computer. 

4.2 HASP Key installation 

The HASP key is a Runtime License hardware key that 
enables Dynoware to operate in full feature mode. The 
HASP key should be installed onto the 25 pin D-Sub 
parallel port connector of your computer. The readme.exe 
notes provide detailed information on installing the HASP 
software. 

4.3 Data Acquisition Board Installation 

The data acquisition board should be installed by someone 
who is familiar with installing computer peripherals and 
familiar with the insides of a computer. If you are unsure 
how to open your personal computer or if your system is 
warranted under a service contract, please have a qualified 
technician install the board. 
 

 

Installation Note: 
The installation CD-ROM contains board specific 
Installation Technical Notes for the various A/D boards 
supplied by Kistler. See these technical notes as well as 
the information below. The procedure to install and 
configure the board is highly dependant on the specific 
board purchased with Dynoware. 
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Warning: 
Make sure to disconnect the power source from your 
computer before opening it. 

 

 

Warning: 
Protect the system and A/D board from static discharge 
by touching the computer chassis to ground yourself 
prior to handling the A/D board. 

4.3.1 PCIM-DAS1602/16  
The following steps are recommended for A/D board 
installation: 
 
1. See technical note K20.302-4e PCIM-DAS1602.pdf 

contained on the installation CD for detailed 
information. 

2. With the power off and the power cord unplugged, 
remove the computer PC cover to gain access to the 
system's expansion slots. Avoid touching any 
components inside the PC. 

3. Touch the metal computer chassis prior to handling the 
A/D board to avoid inducing static shocks. 

4. Set the on board switch to BIP (bipolar) (see your 
board manual). 

5. Set the on board switch to 8 channels (differential). 
6. Select an available PCI slot, and remove the back plate 

metal covers with a screwdriver. 
7. Carefully insert the A/D board into the slot making 

sure that it seats correctly into the computer. Replace 
the slot cover screw, fastening the edge of the board 
to the chassis of the PC. 

8. With the A/D board properly installed, replace the 
cover of the computer and tighten the screws. 

9. Restart the computer. The board will be auto-detected 
by the Plug-and-Play operating system. When 
prompted for the driver, insert the Dynoware CD-
ROM and locate the CBI95.INF file. 

4.3.2 PC-CARD-DAS16/16 
The following steps are recommended for A/D board 
installation: 
 
1. See technical note K20.302-6e PC-CARD-DAS16.pdf 

contained on the installation CD-ROM for detailed 
information. 

2. With the power on and Windows running, insert the 
PC-CARD-DAS16/16 into a PCMCIA type II slot.  

3. Windows will recognize this device as a new device 
and will prompt you to enter the disk with the 
manufacturers drivers. This is the CD-ROM with the 
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Dynoware installation program and containing the file 
CBI95.INF. Place the disk in the drive and continue. 

4. Windows will load the necessary PC-CARD drivers and 
configure the PC-CARD-DAS16/16. 

 

 

Installation Note: 
Any time the PCMCIA or PCI cards are remove and 
reinserted, the INSTACAL program will need to be run. 

4.4 Data Acquisition Board Software Configuration 

The Data acquisition board driver software 
needs to be configured using the board 
configuration program Instacal (found in the 
Measurement Computing program group). 
This program will configure the data 
acquisition drivers for the board. Locate the 
Measurement Computing program group and 
select the Instacal icon to start the data 
acquisition board configuration program.  
 
 
 
 
 
 
 
 
 

Figure 4.3: Instacal board configuration program 

 

Note: 
The Instacal board configuration program will auto-
matically identify and plug-and-play capable data 
acquisition boards. Manually add any non-plug and play 
boards. 

 
Instacal will automatically identify any installed 
plug and play boards. Any non plug-and-play 
board will have to be manually added by 
selecting the Install menu option and then 
selecting the desired board from the list. Instacal 
should be run any time a board is removed from 
a computer (even for PCMCIA card boards). 
 
 
 
 
 
 

Figure 4.4: Configuration for the PCIM-DAS1602/16 
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Note: 
Dynoware will use the board configured in Instacal as 
board zero. By default, the “DEMO-BOARD” is installed 
as board zero. Remove the “DEMO-BOARD” and 
reconfigure the desired board to be zero. (See section 
4.5 below) 

 
Once the board is installed it will need to be configured. 
Right click on the board and select Configure… or double 
click the board. 

4.4.1 PCIM-DAS1602/16 
See technical note K20.302-4e PCIM-DAS1602.pdf 
contained on the installation CD-ROM for detailed 
information. 
 
The following parameters should be set: 

Channels Select 8 channels, differential mode (note: Instacal setting 
must match hardware switch setting). 

Input Mode Bipolar (note: Instacal setting must match hardware switch 
setting). 

Clock Speed Select 10 MHz (note: Instacal setting must match hardware 
switch setting). 

4.4.2 PC-CARD-DAS16/16 
See technical note K20.302-6e PC-CARD-DAS16.pdf 
contained on the installation CD-ROM for detailed in-
formation. 
 
The following parameters should be set: 

Channels Select 8 channel differential mode (note: Instacal auto-
matically controls hardware setting). 

Input Mode Bipolar (note: Instacal automatically controls hardware 
setting). 

Clock Speed Select 10 MHz (note: Instacal automatically controls hard-
ware setting). 

4.5 Set the board number to zero 

Dynoware operates using the Instacal board configured as 
board number zero. By default, “DEMO-BOARD” is 
installed as board number zero. Right click the board zero 
“DEMO-BOARD” and select either Delete (to remove it 
completely) or Change Board# to reconfigure it at a 
different board number. Then Right click the desired board 
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and select Change Board# to reconfigure it as Board zero. 
Your board is now properly configured to operate with 
Dynoware. 
 
The A/D bits, Available channels, Acquisition mode and 
Maximum Channels will be automatically set reflecting the 
board type selected. The gain can be selected in Dynoware 
to your specifications. The gain setting changes the scale 
on the board itself, so the lower the scale means the better 
the resolution. However, it also means a lower overall 
measurement force range, so the user must be careful not 
to choose too high of a gain such that saturation occurs 
(i.e., be sure the forces to be measured do not exceed the 
measuring range of the system. If this occurs, choose a 
lower gain such as ±10 V). 

4.6 Executing Dynoware 

To execute Dynoware, open the newly created Kistler 

Group in the Programs extension of the Start Menu and 
click on the Dynoware icon. 
It is possible to change the program language, see section 
7.2. 

4.7 Connecting the Cables 

There is one (1) 37-pin cable that connects the junction 
box or amplifier to the data acquisition board. To properly 
connect the cable: 
 
1. Shut down the computer and Turn off the power to 

the computer and the amplifier. 
2. Connect the 37-pin cable from the A/D board to the 

junction box or amplifier.  
3. Be sure to tighten any cable-fastening screws by hand 

to secure the cable connections and prevent slippage 
(do not over tighten). 

4. Turn the amplifier and computer on. 
 
If the cables are not long enough, additional cables could 
be connected to the original ones to extend their lengths. 
Excessively long cables are not recommended because 
insulation may not be adequate to prevent interference 
and loss of signal. 
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4.8 Important Issues Regarding Piezoelectric Force Dynamometers 

Please take care to follow these rules applying to 
installation and handling of dynamometers and 
connections: 
§ Protect the signal conditioner and cable connector 

ends from dust and moisture. Close end caps. 
§ Dynamometer mountings must be level and properly 

secured. 
§ Use caution connecting and removing the cables. Also 

take care to not step on the cable connections to avoid 
shearing off the cable. 

4.9 Charge Amplifiers 

Dynoware automatically controls the range selection, filter 
selection and operate/reset functions of several types of 
Kistler charge amplifiers. Charge amplifiers should be 
allowed to warm up sufficiently for most accurate 
measurements, with 30 minutes being a minimum. Unplug 
the amplifier if it is not to be used for a very long time. 
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5. Quick Start 

This section will help familiarize the new user with 
Dynoware.  
Data cannot be acquired until the hardware is properly 
configured. This section is meant as an overview to the 
features of Dynoware that will be applied to acquired trials 
and graphs once the proper configurations have been 
performed. For more information on configuring 
Dynoware, refer to section 6.2. 

Figure 5.1: Running Dynoware from the Start menu  

 
Start Dynoware by choosing: 
Start → Programs → Kistler → DynoWare. 
 
The splash screen appears briefly. The splash screen (Figure 
5.2) shows current application version and product type 
information. 
 

Figure 5.2: The Dynoware Splash Screen 
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The File menu allows you to open stored trials, print, save, 
export, manage configurations and exit the program. The 
print setup can be customized here also. Feel free to open 
some of the supplied trials and manipulate them to help 
familiarize you with the program’s capabilities. 
 
The Acquisition menu is where hardware is configured and 
where acquisition is performed. Choosing Acquisition à 
Hardware will bring up the Hardware Dialog Box (Figure 
5.3) showing the configuration settings. Choosing 
Acquisition à Setup allows the user to configure data 
acquisition specific parameters (Figure 5.4). Acquisition à 
Start will begin the acquisition process. 

Figure 5.3: Hardware Configuration Dialog 

 

 
Figure 5.4: Acquisition Edit 

 
The View menu allows the user to configure Dynoware 
graphic preferences and to edit the trial documentation. 
Selecting View à Setup (section 6.3.3) allows configura-
tion of the default graphs that appear when a file is 
opened or a trial is acquired. With View à Edit the content 
of an individual graph can be changed (6.2.2).  
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Double clicking on a specific feature of the graph (title, 
legend or axis title) provides editing capability. 
 
The view can be changed at any time without adversely 
affecting the data in any way. A user may also zoom the 
displayed area, enable/disable grid lines, display a moving 
cursor, and edit labels and documentation information 
from the View menu. 

Figure 5.5: View Edit 

The Analysis menu gives options for filtering data and 
removing signal drift. Refer to the online help system for 
detailed information on these topics. 
 
The Tools menu provides two methods for displaying real-
time voltage data: Oscilloscope and Voltmeter. These tools 
are designed for simple troubleshooting of the system. 
 
The other menu that appears when a graph is shown is the 
Window menu. The Window menu uses standard 
Microsoft Windows commands to arrange active windows. 
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6. Reference 

This section describes the menus used in Dynoware. 

6.1 File...  

Depending on whether or not a graph is open on the 
screen, the File menu will have a different appearance. If 
no graph is open, there will only be commands to open, 
load/save configurations, export data and exit Dynoware. 

6.1.1 Open…  
This will bring up a open file open dialog box (Figure 6.1: 
File Open) where the desired trial can be selected for 
viewing. The default directory is the data directory, though 
the dialog box can be easily navigated using standard 
Windows techniques to browse other drives, directories, 
and network computers. The extension for the trials are 
“*.dwd”. Files stored in Dynoware 1.x format will 
automatically be converted and loaded. 

Figure 6.1: File Open 

The Add button will add the selected file (as will double 
clicking it in the Name list) to the Open File selection. The 
Remove button will clear the Open File selection. 
 
If a valid configuration file exists, the Load Config check 
box will be available and the user can choose to load the 
configuration options associated with the file (hardware 
setup, data acquisition, and view setups). If a configuration 
was not stored for the data file, this option will be disabled 
and appear grayed out.  
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6.1.2 Configuration...  
The Hardware, Data Acquisition and View settings can be 
loaded or stored to a file. The default extension for 
configuration files is “*.cfg”. 

6.1.2.1 Load… 

To load the Hardware, Data Acquisition and View settings 
from a configuration file select Configuration Load. This 
will overwrite the existing Dynoware configuration 
settings. A standard Windows file open dialog box (Figure 
6.2) will be presented to select the appropriate 
configuration file to load. To load a configuration file 
automatically when a data file is opened enable the Load 
Config option in the File Open dialog box (See section 
6.1.1 above). 

Figure 6.2: Configuration Load 

6.1.2.2 Save… 

To store the Hardware, Data Acquisition and View settings 
to a configuration file select Configuration Save. A 
standard Windows file save dialog box will be presented to 
select the appropriate configuration file name to save the 
current settings to. The default extension of configuration 
files is “*.cfg”. Configuration files can be saved auto-
matically by checking the Save configuration option in the 
Acquisition Edit dialog box (See section 6.2.2) 

6.1.3 Export… 
Files may be exported to ASCII delimited text files by 
selecting File Export (e.g. for further evaluation in 
Microsoft EXCEL). The Export Dialog (Figure 6.3) allows for 
the selection of the cycles to export, and the channels to 
export. The user can also select the data delimiter or enter 
a user-defined delimiter.  
The Browse button allows the user to use the standard 
windows file chooser dialog box to select the destination 
Export file name. Another box pops up to display export 
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progress. An example of an exported file is shown below. 
Use the Select/Unselect All buttons to select or clear 
export selection for channels and cycles in the trial. 
 

Note, if the tab delimitation is 
selected, the file can be imported 
directly by Microsoft Excel using the 
default import options of Excel. 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.3: Export Dialog 

Example of an exported file: 
 

FILE TYPE:   

Path: C:\DynoWare_Data\IPL-Tagung\  

Filename: 5A-Fraesen_Aussen_2.dwd  

Config ID: 5A-Fraesen_Aussen_2.cfg  

Setup ID: 0  

Manipulated: 0  

Filename 1:    

Filename 2:    

Date: Monday, 12 September , 2000  

Time: 13:43:19  

Sampling rate [Hz]: 3000  

Measuring time [s]: 90  

Delay time [s]: 0  

Cycle time [s]: 0  

Cycles: 1  

Samples per channel: 270001  

Cycle interval: 0  

Channel enabled: 1 1

Cycle No: 1  

Time [s] Fz Mz 

0 -2.83203 2.44E-03

3.33E-04 -3.11523 -4.88E-03

6.66E-04 -3.11523 -2.44E-03

1.00E-03 -3.11523 -2.44E-03

1.33E-03 -2.83203 -2.44E-03

1.67E-03 -2.54883 -2.44E-03

... ... ...

2.67E-03 -2.54883 -2.44E-03

File Data 

File Header Information

File Header Information
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6.1.4 Print... 
Shortcut: Ctrl+P 
 
Print brings up the Print dialog box (Figure 6.4: 
Print Dialog) using the default print settings. The 
user selects the views to be printed by clicking 
on the views in the list and highlighting them 
yellow. The Document title appears as the 
default graph title but the user can change the 
text here. Pressing the Select All button will 
highlight all open views to be printed. Other 
options enable the printing of the Amplifier and 
Acquisition configuration at the bottom of the 
printout, previewing the printout on screen prior 
to making a hardcopy, and printing to a file for 
later viewing.  
 
Some printout information will be disabled if the 
selected view contains Multiple cycle data.  
 
 

Figure 6.4: Print Dialog 

After selecting OK, the Printer selection dialog 
will appear allowing the user to change the 
printer and select the number of copies to print. 
 
If the Preview option was checked the print 
preview screen will appear (see section 6.1.5). 
 
 
 
 
 
 
 
 
 

Figure 6.5: Printer Selection 

6.1.5 Print Preview 
The Print Preview is identical to the Print function above 
except the output appears on the monitor. This allows the 
user to see what the printout will look like on the prior to 
printing (Figure 6.6: Print Preview Screen) so that any 
necessary changes can be made before the print function is 
carried out. From this dialog box you can zoom in on the 
image for a closer look, create a print file, directly email a 
print file and execute the hardcopy Print function. 
 
A print file is a special "*.ll" file that can be viewed with a 
special viewer. The special viewer, LLViewer, is available on 
the installation CD-ROM in the LLViewer subdirectory or in 
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the installation directory - by default C:\Kistler\Dynoware\. 
Run the LLView.exe installation program and follow the 
onscreen instructions. Files directly emailed will need the 
LLViewer to view the email contents. 

 

Figure 6.6: Print Preview Screen 

6.1.6 Print Setup… 
Print Setup… allows the user to configure the printing 
specifications. Standard setup functions are to select the 
printer, paper size and tray (if applicable), and the paper 
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orientation. A Properties button allows to further customize 
printer settings. 

6.1.7 Copy to Clipboard 
This will copy the active window contents to the Windows 
clipboard. The graph can then be pasted into a word 
processing or spreadsheet application as a graphic. 

6.1.8 Exit 
Exit closes Dynoware. Since changes to the data are 
continuously stored in the file, no extra question is 
necessary about saving changes. 

6.2 Acquisition... 

The Acquisition menu is where all data acquisition and 
hardware configuration is performed. 

6.2.1 Hardware… 
Shortcut: Alt+H 

Figure 6.7: Hardware configuration 

The Hardware dialog box (Figure 6.7: Hardware 
configuration) allows the user to customize specific 
equipment used in the system. The dialog has several 
different tabs dependent upon the specific amplifier 
configured in the system. There are five major items that 
can be configured: The A/D board, The amplifier, The 
amplifier communication interface, The dynamometer, and 
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the specific calculations to be performed with 
dynamometer data. 

6.2.1.1 A/D Board 

The A/D board is automatically 
selected from the Instacal board 
configuration program from 
Measurement Computing (see 
section 4.4). This tab (Figure 6.8: 
A/D Board) shows the configured 
A/D Board (board 0 in Instacal) and 
allows the user to edit the A/D 
board gain selection (A/D Board 
Full Scale measurement range in 
volts).  
 
 
 
 

Figure 6.8: A/D Board 

Information displayed is: 

Board  Displays the A/D Board that is configured in the Instacal 
program. 

Full Scale The Full Scale input defines the resolution of the A/D 
Board: Small Full Scale = more resolution per volt, Note: All 
input voltage signals to the board must be smaller than the 
defined Full Scale. 

Description Description of the A/D Board manufacturer. 

Max. Throughput  Displays maximum throughput of the A/D Board. 

Resolution Displays resolution of the A/D Board. 

Analog Channels Displays the maximum number of the analog channels 
available. 

Digital Channels Displays the maximum number of the digital channels 
available. 

6.2.1.2 Show Hardware Dialog between acquisition cycles 

If enabled, the hardware dialog will appear prior to 
acquiring data for a cycle. The checkbox enables or 
disables this option. Only changes to the amplifier settings, 
and operate reset state are allowed once placed into the 
data acquisition mode. Select the Acquisition à Hardware 
option to re-enable this option, or to make extended 
changes to the configuration. 

6.2.1.3 Amplifier Selection 

The user should first choose the amplifier selection (Figure 
6.9: Amplifier Selection) from the bottom of the dialog, 
Supported amplifiers are the 5017/5019, 5011/5015, 
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Rotating Cutting Dynamometer 5223, High Speed 
Rotating Cutting Dynamometer 5237 and Other user 
defined amplifiers. This selection will modify the available 
tabs for setting other specific hardware settings. 

Figure 6.9: Amplifier Selection 

6.2.1.4 Configurations using Amplifier 5017/5019 

Selecting 5019/5017 in the amplifier selection (see section 
6.2.1.3 above) will enable the multichannel 5017/5019 
tab, the RS-232C Setup tab, and the Multicomponent 
Measurement tab.  

6.2.1.4.1 Multichannel Amplifier 5017/5019 

The multichannel configuration tab allows for customi-
zation of the 5017 or 5019 multichannel charge amplifier. 
There are several configurable parameters associated with 
this amplifier: 

Chan Channel number displays the specific channel number 
ranging from 1 up to 8.  

Label Enter a label of each channel. This label will appear on 
graphs and reports. 

Measuring Range Enter the Measuring Range (Maximum measurable 
amount) [M.U.] of each channel (M.U. = Mechanical Unit). 

Unit Enter the display units of each channel. 

Scale The Scale setting for the amplifier is automatically 
determined from the Measuring Range and the full scale 
output capability of the amplifier. Scale [M.U./V] = 
Measuring Range [M.U.] / 10.0 V 

Sensitivity Enter the sensitivity of a sensor (see calibration sheet). 

Filter Select the desired Low Pass filter (internal filter in the signal 
conditioner) to be used. 

Time Constant Select the desired High Pass filter Time Constant (internal 
signal filter in the signal conditioner) to be used. 

Operate Transmit the command to place the amplifier into the 
operate mode. 

Reset Transmit the command to place the amplifier into reset 
mode. 

Send Parameters Transmit the command to set the appropriate per channel 
configuration for Sensitivity, Range, Filter, and Time 
constant settings. 

Reset/Operate Enable the automatic control (via RS-232C interface) of the 
Operate/Reset commands during a typical acquisition 
cycle. Amplifier will be automatically set to operate at the 
start of a cycle, and will return to reset after the acquisition 
has completed for any given cycle. In some cases, this 
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automatic control of Reset/Operate is not desired and the 
selection box should remain unchecked. 

6.2.1.4.2 RS-232C Setup 

The RS-232C configuration should be properly configured 
using the RS-232C Setup Tab for the 5017 or 5019 to 
function properly. 

Serial Port Selects the COM port used to control the signal 
conditioner. This is the port on the pc where the serial 
cable is connected. 

Baudrate Selects the data transmission rate used to communicate 
with the signal conditioner. This setting must be identical 
to the setting in the signal conditioner. Refer to the signal 
conditioner manual to determine the proper setting. 

Data Bits Selects the number of data bits used in the data 
communication protocol. This setting must be identical to 
the setting in the signal conditioner. Refer to the signal 
conditioner manual to determine the proper setting. 

Stop Bit Selects the number of stop bits in the data transmission 
protocol. This setting must be identical to the setting in the 
signal conditioner. Refer to the signal conditioner manual 
to determine the proper setting. 

Parity Selects the parity checking used during communication 
with the signal conditioner. This setting must be identical 
to the setting in the signal conditioner. Refer to the signal 
conditioner manual to determine the proper setting. 

Handshaking Selects the handshaking method used during communica-
tion with the signal conditioner. This setting must be 
identical to the setting in the signal conditioner. Refer to 
the signal conditioner manual to determine the proper 
setting. 

 

 
 

Note: 
Typically the communication is configured for COM1, 
9600 baud, 8 data bits, 1 stop bit, no parity, and 
Hardware handshaking. 

6.2.1.4.3 Multicomponent Measurement 

With the multichannel Amplifier Type 5017 and the 
appropriate hardware, additional software calculations can 
be performed. These calculations can provide resultant 
forces and moments for various types of dynamometers, in 
a variety of applications. If a multichannel calculation is 
enabled, the user cannot enable/disable channels in the 
configuration (Section 6.2.2.2). Select the multicomponent 
calculation type from the list presented corresponding to 
your specific hardware dynamometer. 
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6.2.1.4.3.1 Mode Off 

Multicomponent calculations are disabled. 

6.2.1.4.3.2 Type 1 

The type 1 dynamometer measures 4 shear components 
and 1 vertical component. From the raw components Fx, Fy, 
Fz and Mz are calculated. The user must configure the a1, a2, 
b1, and b2 distances. 
 
 
 
 
 
 
 
 
 
 

6.2.1.4.3.3 Type 1a 

The type 1a dynamometer measures 4 shear components 
and 4 vertical components. From the raw components Fx, 
Fy, Fz and Mz are calculated. The user must configure the 
a1, a2, b1, and b2 distances. 
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6.2.1.4.3.4 Type 2 

The type 2 dynamometer measures 2 shear components 
and 4 vertical components. From the raw components Fx, 
Fy, Fz and Mx, My are calculated. The user must configure 
the a and b distances. 
 
 
 
 
 
 
 
 
 
 

6.2.1.4.3.5 Type 3 

The type 3 dynamometer measures 4 shear components 
and 2 vertical components. From the raw components Fx, 
Fy, Fz and Mx, Mz are calculated. The user must configure 
the a and b distances. 
 
 
 
 
 
 
 
 
 
 

6.2.1.4.3.6 Type 4 

The type 4 dynamometer measures 4 shear components 
and 4 vertical components. From the raw components Fx, 
Fy, Fz and Mx, My, Mz are calculated. The user must 
configure the a and b distances. 
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6.2.1.4.3.7 Type 5 

The type 5 dynamometer measures 5 shear components 
and 3 vertical components. From the raw components Fx, 
Fy, Fz and Mx, My, Mz are calculated. The user must 
configure the a, b and c distances. 
 
 
 
 
 
 
 
 
 
 

Sensor Distances Enter the appropriate distances between sensors from the 
drawing given for the appropriate dynamometer type. All 
distances are entered in Millimeters [mm]. 

Dynamometer View This window shows a drawing defining the coordinate 
system, and sensor layout for the selected dynamometer. 
Use this as a guide when entering sensor distances, 
configuring your system, and interpreting data. 

Resultant Window The resultant window shows channel allocation for 
acquired and calculated channels. This should be used as a 
guide when configuring graphs. 

6.2.1.5 Configurations using 5011/5015 amplifiers 

Selecting 5011/5015 in the amplifier selection (see section 
6.2.1.3 above) will enable the Charge Amplifier Type 
5011/5015 tab. 

6.2.1.5.1 Charge Amplifier Type 5011/5015 

The following parameters should be set when using 
5011/5015 charge amplifiers in Dynoware: 
 

Communications Selection The user can select the remote control mode, either via RS-
232C (in which case only channel one can be remotely 
controlled) or via IEEE-488 (in which case all channels can 
be remotely controlled). If RS-232C is chosen, a RS-232 
Setup tab will appear to allow custom configuration of the 
communication parameters. 

Channel Channel number. Channels range from 1 to 8.  

Label Enter a label of each channel. This label will appear on 
graphs and reports. 

Measuring Range Enter the Measuring Range [M.U.] of each channel (M.U. 
= Mechanical Unit). 

Unit Enter the display units of each channel. 
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Scale The Scale setting for the amplifier is automatically 
determined from the Measuring Range and the full scale 
output capability of the amplifier. Scale [M.U./V] = 
Measuring Range [M.U.] / Amplifier Full Scale Output [V]; 
(M.U. = Mechanical Unit) 

Sensitivity Enter the sensitivity of a sensor (see calibration sheet). 

Filter Select the desired Low Pass filter (internal signal filter in the 
signal conditioner) to be used. 

Time Constant  Select the desired High Pass filter Time Constant (internal 
signal filter in the signal conditioner) to be used. 

IEEE Address Enter the IEEE-488 address of the selected 5011/5015. The 
selected channel address must match the address 
configured in the 5011/5015. Please refer to the 
5011/5015 users manual for information on configuring 
the IEEE-488 address. Each device must have a unique 
address. This applies only if IEEE communication mode is 
selected. 

Operate Transmit the command to place the amplifier into the 
operate mode. 

Reset Transmit the command to place the amplifier into reset 
mode. 

Send Parameter Transmit the command to set the appropriate per channel 
configuration for Sensitivity, Range, Filter, and Time 
constant settings. 

Reset/Operate Enable the automatic control (via RS-232C or IEEE-488 
interface) of the Operate/Reset commands during a typical 
acquisition cycle. Amplifier will be automatically set to 
operate at the start of a cycle, and will return to reset after 
the acquisition has completed for any given cycle. In some 
cases, this automatic control of Reset/Operate is not 
desired and the selection box should remain unchecked.  

6.2.1.5.2 RS-232C Setup  

(See section 6.2.1.4.2) – This tab will only appear if RS-
232C interface is selected. 

6.2.1.6 Configurations using Other amplifiers 

Selecting Others in the amplifier selection (see section 
6.2.1.3 above) will enable the Other tab. 

6.2.1.6.1 Others 

The other adapter tab allows for generic amplifier 
configuration. In this setup no specific equipment is cont-
rolled. The data provided allows Dynoware to convert data 
from measured voltages to real mechanical units. The 
information configured in this tab is: 

Channel Channel number used for configured devices and con-
nections. 
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Label Enter the label for each channel. Labels will appear on 
graphs and reports. 

Measuring Range Enter the measuring Range of each channel (if not 
activated, use double click or F4). You can either enter an 
overall measuring range, or an individual range and 
sensitivity. Measuring Range [M.U.] = Sensor Range [pC] 
divided by Sensitivity [pC/M.U.] (M.U. = Mechanical Unit). 

Unit Enter the unit of each channel. The configured units will 
appear on graphs and reports 

FS Enter the full scale (FS) of each channel. 

Range 1 Enter the range of the adapter for each channel (activate 
with double click or F4). 

Sensitivity Enter the sensitivity of a sensor (activate with double click 
or F4). 

6.2.1.7 Configurations using Rotating Cutting Dynamometer 5223 

Selecting RCD 5223 in the amplifier selection (see section 
6.2.1.3 above) will enable the RCD 5223 tab, the RS-232C 
Setup tab, and the RCD Calculations tab. 

6.2.1.7.1  RCD 5223 

The rotating cutting dynamometer requires the configu-
ration of the following parameters: 

Channel Channel number. Channels range from 1 to 6.  

Label Assign labels for each channel. These labels appear in 
graphs and reports. 

Measuring Range The measuring range is automatically assigned based on 
the Scale and Sensitivity settings. Measuring Range [M.U.] 
= Full Scale Output [mV] divided by Sensitivity [mV/M.U.]; 
(M.U. = Mechanical Unit). 

Unit Assign units to each channel. These labels appear in graphs 
and reports. 

Full Scale Output (FSO) Assign the full scale setting for the amplifier in [mV]. 

Sensitivity Enter the sensitivity of a sensor in [mV/M.U]. 

Range Selection Select the desired measurement range. 

Zoom Channel Select the channel to appear as the zoom output channel. 
You can select Fx, Fz or Mz. 

Operate Transmit the command to place the amplifier into the 
operate mode. 

Reset Transmit the command to place the amplifier into reset 
mode. 

Send Parameters Transmit the command to set the appropriate per channel 
configuration for Sensitivity and Range settings, and the 
zoom channel selection. 
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Reset/Operate Enable the automatic control (via RS-232C interface) of the 
Operate/Reset commands during a typical acquisition 
cycle. Amplifier will be automatically set to operate at the 
start of a cycle, and will return to reset after the acquisition 
has completed for any given cycle. In some cases, this 
automatic control of Reset/Operate is not desired and the 
selection box should remain unchecked.  

6.2.1.7.2 RS-232C Setup  

(see section 6.2.1.4.2) 

6.2.1.7.3 RCD Calculations 

With the RCD 5223... additional software calculations can 
be performed. These calculations can provide radial and 
tangential forces or active force in a variety of applications. 
If a RCD calculation is enabled, the user cannot en-
able/disable channels in the Channels & Trigger configu-
ration (see section 6.2.2.2). 

6.2.1.7.3.1 Off 

RCD Calculations are disabled  

6.2.1.7.3.2 Type 1 

The type 1 RCD Calculation computes the Fa (active force) 
cutting force parameter. The user must configure tool 
diameter, D. 
 
 
 
 
 
 
 
 
 

 
 

6.2.1.7.3.3 Type 2 

The type 2 RCD Calculation computes the Fr (Radial Force) 
and Ft (tangential force) cutting force parameters. The user 
must configure tool diameter, D. 
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Tool Diameter Enter the tool diameter for the appropriate tool under test. 
All distances are entered in millimeters, "mm". 

Tool View This window shows a drawing defining the coordinate 
system, and tool measurement layout for the selected 
dynamometer.  

Resultant Window The resultant window shows channel allocation for 
acquired and calculated channels. This should be used as a 
guide when configuring graphs.  

6.2.1.8 Configurations Using Rotating Cutting Dyno 5237 (High Speed RCD) 

Selecting RCD 5237 in the amplifier selection (see section 
6.2.1.3 above) will enable the RCD 5237 tab, and the RS-
232C Setup tab. 

6.2.1.8.1  RCD 5237 

To configure the 5237 high speed rotating cutting 
dynamometer, configure the following:  

Channel Channel number. Channels range from 1 to 2.  

Label Assign labels for each channel. These labels appear in 
graphs and reports. 

Measuring Range The measuring range is automatically assigned based on 
the Scale and Sensitivity settings. Measuring Range [M.U.] 
= Full Scale Output [mV] divided by Sensitivity [mV/M.U.]; 
(M.U. = Mechanical Unit) 

Unit Assign units to each channel. These labels appear in graphs 
and reports. 

Sensitivities Range I, Range II and Range III – enter the sensitivity of a 
sensor in [mV/M.U.] for each of the calibrated ranges. 

Range Selection Select the desired measurement range from the pull-down 
choice box. 

Operate Transmit the command to place the amplifier into the 
operate mode. 

Reset Transmit the command to place the amplifier into reset 
mode. 

Send Parameters Transmit the command to set the appropriate per channel 
configuration for the Range settings. 

Reset/Operate  Enable the automatic control (via RS-232C interface) of the 
Operate/Reset commands during a typical acquisition 
cycle. Amplifier will be automatically set to operate at the 
start of a cycle, and will return to reset after the acquisition 
has completed for any given cycle. In some cases, this 
automatic control of Reset/Operate is not desired and the 
selection box should remain unchecked.  
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6.2.1.8.2 RS-232C Setup 

(see section 6.2.1.4.2) 

6.2.2 Edit…  
Shortcut: Alt+E 
 
Selecting Acquisition → Edit (Figure 6.10: Edit Acquisition 
Parameters) allows configuration of the data acquisition 
process for DynoWare. The parameters tab provides 
configuration of the basic sampling and storage criteria. 
The Channels and triggers tab provides selection of the 
trigger method and the channels available. The Data 
Manipulation Online tab allows for user customized data 
calculations to be performed on acquired data. 

 

 
Figure 6.10: Edit Acquisition Parameters 

6.2.2.1 Parameter 

The Parameter tab (Figure 6.10: Edit Acquisition 
Parameters) allows for configuration of the following: 

Measuring Time Definition of the actual duration of acquisition measured in 
seconds. 

Sample Rate The Sample rate defines the number of measurements per 
second and per channel. 

 

 
 

Note: 
The higher the sample rate, the better is the resolution of 
the measuring signal. 
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Note: 
Because of the huge amount of data a high sample rate is 
automatically equivalent to slow data processing and a 
slow building up of the graphical display. According to 
experience a sample rate of 250 Hz could be sufficient for 
monitoring purposes. For detailed analysis however 2'000 
Hz or higher might be necessary. 

 

 
 

Note: 
High sampling rates and long acquisition duration can 
create large files. Ensure that there is enough disk space 
available when using continuous monitoring. 

 

Cycles This defines the number of measuring cycles (machine 
cycles) to be acquired. 

Continuous If checked the number of cycles is unknown. The 
acquisition has to be stopped manually.  

Trigger Delay Time The delay time between the trigger signal and 
measurement start. 

Save  Enable saving the acquisition data into a file after each 
cycle is acquired. 

Display Enable displaying acquired data on the screen after each 
cycle is acquired. 

Information Displays information about the number of Channels used 
for the measurement, the number of Samples/Channel, 
and the approximate memory storage size needed for one 
cycle. This depends on the number of channels, the 
sampling time, and the sampling rate. 

File the name of the file. The file extension is '*.dwd' . 

Browse Browse enables visual selection of a directory and a file 
name, use the Browse function to find and overwrite an 
existing file or to browse for a directory (folder). 

Directory Displays the selected directory or folder on a disk where 
the file will be stored. 

Save configuration Enable the check to save the configuration when starting 
the measurement. Dynoware uses the same file name as 
for the data file, but with the extension '*.cfg' for 
configuration files. See Section 6.1.2.2 Configuration 
Save… for more information about configurations. 

6.2.2.2 Channels & Trigger 

The Channels and Trigger tab (Figure 6.11: Edit Acquisition 
Channels & Trigger) is configured with the following 
options in the table and trigger sections: 
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On (Enable) Activates/Deactivates a channel if multicomponent 
measurement mode is not activated. 

Trigger Activate a channel as a 'trigger channel' in case of analog 
trigger mode. 

Channel Displays the number of the channel. 

Label Enter the label of the channel (e.g. drilling moment). 

Trigger: On enter key  The measurement is started by pressing the enter key. 

Trigger: Digital The measurement is started by an external trigger signal 
(e.g. start machine). 

Trigger: Analog The measurement is started if the defined channel has 
reached a certain level. 

Trigger: Rising/Falling Start of the Trigger at rising or falling edge. 

Trigger: % or Absolute The analog trigger threshold is defined as a percentage or 
an absolute value. 

Threshold specifies in M.U. (mechanical units) or volts the analog 
trigger threshold.  

 

 
Figure 6.11: Edit Acquisition Channels & Trigger 
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6.2.2.3 Data Manipulation Online 

 
Figure 6.12: Edit Acquisition, Data Manipulation Online 

Data for any specified channel can be modified with 
standard mathematical functions immediately after the 
data is acquired. The source channels and operation to be 
performed must be specified as well as the destination of 
the calculation.  
 

 
 

Warning: 
The destination channel data is permanently destroyed. 
Use the data manipulation functions with extreme 
caution. To create a new data set, enable acquisition of 
an additional channel (placeholder). 

 

On (Enable)  Activate the function for the data manipulation. 

1. Base First channel for the data manipulation. 

2. Base Second channel for the data manipulation. Here you may 
also enter constant values. Note: Confirm numerical entries 
with RETURN. 

Operation The mathematical operation to be performed. The 
following functions are available: Addition, Subtraction, 
Multiplication, Division, loga, lnb, exp(e)c, exp(10)d. 

Result Channel to place the result. 

Add Add a new function. 
                                                   

 
a base 10 logarithm 
b natural logarithm 
c natural exponential 
d base 10 exponential 
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Remove Remove the selected function. 

6.2.3 Start... 
Shortcut: Alt+S 
 
To begin the data acquisition process, select the 
Acquisition → Start menu choice. If the specified storage 
file already exists (as specified in section 6.2.2.1 Acquisition 
Parameter) a prompt will appear (Figure 6.13: Overwrite 
File Prompt) to overwrite the existing file.  
 

 
 

Warning: 
If you choose to overwrite the file, all existing data in 
the file will be lost. 

Figure 6.13: Overwrite File Prompt 

 
First, if the enabled, the Comments dialog (see Section 
6.3.4.1) will appear. Here notes about the given cycle can 
be added or changed to document the trial cycle. 
 
Next, if Show Hardware dialog between Acquisition Cyc-
les is enabled (see Section 6.2.1.2 Show Hardware Dialog 
between acquisition cycles), the Hardware configuration 
dialog will appear allowing changes to the amplifier 
configuration. 
 
Finally, the main data acquisition dialog box (Figure 6.14: 
Begin Acquisition Prompt) will appear showing the current 
cycle number. If analog or digital triggering is required, the 
system will go into the wait for trigger state. If Key 
triggering is enabled pressing the Go button or the Enter 
key will start acquisition. Once a trigger has occurred, or 
Go has been selected, the progress bar will update to 
indicate acquisition status. 
To abort acquisition (or stop a continuous cycle acqui-
sition), press the Stop button.  
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Figure 6.14: Begin Acquisition Prompt 

 
 

Warning: 
The data acquisition process may take several seconds to 
abort before the next acquisition interval can begin. 

6.3 View... 

The view menu provides for complete control of the 
graphical output of Dynoware. Graph types and data con-
tent can be selected for individual views and for configura-
tion of a default view set. 

6.3.1 New… 
With a specific window open, selecting New… will create a 
new duplicate window with the identical configuration as 
the current active window. This new view can now be 
configured individually. 

6.3.2 Edit…  
Shortcut: Alt+V 
 
The View Edit configuration provides for control of the 
current windows graph type and contained items (Figure 
6.15: View Edit). The user can also customize the colors of 
a specific graph item from this dialog box, and set view 
dependence (link to other open views of this file). 
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Figure 6.15: View Edit 

Selected Cycles and Channels are highlighted in yellow. 
Click on an item to highlight (or select) it, click on a 
highlighted item to unselect it. There are three types of 
graphics: y(t), y(x), and numerical. In order to select or 
change the x-axis in a y(x) graph, click on the y-x icon.  
The following describes additional items in the View Edit 
dialog: 
 

File Displays the files to be selected. 

Cycle Selects the cycles to be displayed in the view. If more than 
two cycles are selected, they will be superimposed. 

Channel Select the channels to be displayed. 

Color Shows the color selection for each channel. Press the Select 
Color button to change the color. 

vs. Y2 Selecting vs. Y2 allows graphing vs. two vertical axis scales. 
One scaling will appear on the left of the graph, the 
second scale will appear on the right of the graph. The 
legend will indicate the corresponding axis that applies to 
each line. vs. Y2 applies to time based graphs y(t) only. 

Select all/Unselect all Selects/Unselects all cycles or channels to view. 

Select Color  Change the color for each channel. 

View dependence Links two or more windows. Changing in one window 
from one cycle to the next will update the other windows 
accordingly. 
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6.3.3 Setup… 

 
Figure 6.16: View Setup 

With View → Setup you can configure the windows and 
default graphs that will appear when a file is opened or 
when data is acquired. A user can configure several default 
windows by repeatedly pressing the Add button and 
following the onscreen wizard for creating a new view 
window. To remove an existing view, highlight the view in 
the Data Views window and select the Remove button. 
 
To find more information about a view, highlight it in the 
Data Views window and press the Details button. 

6.3.4 Documentation 
Shortcut: Alt+D 
 
Each individual cycle can have additional documentation 
associated with it. There are two tabs in the documentation 
dialog, Comments and File, Date, Time. 

6.3.4.1 Comments 

The comments tab (Figure 6.17: Documentation) allows 
user entered text data to be associated with each cycle. 
The changes are updated immediately in the file. 
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Figure 6.17: Documentation 

Document title Allows for customization of the graph titles 

Remarks General text comments can be entered in the remarks 
section 

Material In cutting force documentation mode, the user can supply 
a material type comment 

Tool In cutting force documentation mode, the user can enter 
specific information about the cutting tool under test. 

Cutting Force Parameters vc = cutting velocity [m/min] 
F = feed [mm/rev] 
ap = depth of cut [mm] 
n = speed [rpm] 
vf = feed velocity [m/min] 
ae = cutter engagement [mm] 

Documentation Mode specify to document specific cutting force parameters, or to 
document the file using general comments. 

Show Documentation between acquisition cycles enable the automatic display of 
the documentation dialog box immediately prior to 
acquiring a cycle. 

6.3.4.2 File, Date, Time 

The File, Date, Time tab documents the temporal and storage data associated with the original 
acquisition. 

Folder The directory where the file was initially created 

File The initial name of the file 

Date The original date of the acquisition 

Time The original time of the acquisition 
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6.3.4.3 Edit Labels 

The user can edit the channel labels or unit labels of 
specific channels at any time using the View → Edit Labels 
selection. The channel label or unit entered for any one 
specific channel will be applied to all of the stored cycles 
within the file. The changes are updated immediately in the 
file. 

6.3.5 Zoom 
The zoom function provides for changing the x-axis and y-
axis scaling parameters for an active graph. The user can 
manually zoom by entering the axis minimum and 
maximum values or graphically zoom using the right 
mouse button. 

6.3.5.1 Manual Zoom 

By default all graphs are scaled to best fit the minimum and 
maximum values of the contained graphs. Selecting View 
→ Zoom (Figure 6.18: Manual zoom) presents a dialog box 
which can be used to set the x-axis minimum and 
maximum values and the y-axis minimum and maximum 
values. The dialog box will remain active (button Apply) so 
that the user can switch to other open windows and 
change the zoom settings. New settings will be activated 
when the OK or apply buttons are selected. The Zoom Off 
button will restore the graph to the original auto scaled 
values. 
 

 
 

Note: 
A zoomed graph will have the word 'zoom' in the upper 
left corner of the window.  

 

 
Figure 6.18: Manual zoom 

6.3.5.2 Graphical Zoom 

It is possible to zoom by clicking the right mouse button 
and dragging to create a Window over the desired zoom 
area of a graph. When the right mouse button is released, 
the graph will be redrawn with the new coordinates. 
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6.3.6 Zoom Out 
Zoom Out will restore the graph to the original auto scaled 
values. Also, by double clicking the right mouse button, the 
graph will return to the original coordinate scaling. Zoom 
Out is deactivated if the graph is currently not zoomed.  

6.3.7 Cursor 
For the analysis of data it is helpful to display the x- and y-
coordinates. Pressing the toolbar icon  

  
or selecting View → Cursor from the menu will enable the 
cursor tool. The dashed vertical cursor line can be moved 
with the mouse or with the keys. 
1.) Move the mouse over the dashed vertical cursor line. 

The mouse cursor will change to . 
2.) Click the left mouse button and drag the line to a new 
position (cursor will change to when dragging) 
3.) Release the mouse, the data in the cursor box will be 
updated. 
 
Alternatively: 

1.) Move the vertical cursor one sample by pressing the left 
or right arrow keys:  

2.) Move the vertical cursor 5% by pressing the page up or 
page down keys. 
 
The cursor window can be moved anywhere on the 
desktop by left clicking the mouse on the toolbar, and 
dragging to a new location. Dynoware will remember the 
last active state and last active location of the toolbar each 
time it is started. 
 
When activated, the cursor tool will apply to all time base 
graphs y(t) and tables (numerical graphs). Numerical 
graphs will have the cursor identified by a highlighted row. 
 
If the graphs have view dependence enabled (Section 6.2.2 
View Edit) all graphs based on the same document will 
have the cursor adjusted to the same time. 
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Figure 6.19: Cursor Tool 

6.3.8 Horiz. Grid 

Selecting View → Horiz. Grid from the main menu, or 
selecting the  

  
icon on the toolbar will redraw the active graph with 
horizontal grid lines enabled. Selecting the option again will 
disable the horizontal grid lines. 

6.3.9 Vert. Grid 

Selecting View → Vert. Grid from the main menu, or 
selecting the  

  
icon on the toolbar will redraw the active graph with 
vertical grid lines enabled. Selecting the option again will 
disable the vertical grid lines. 

6.3.10 Toolbar 

Selecting View → Toolbar will toggle the visible state of 
the system toolbar. The functional descriptions are: 

 

 File Open 

 Hardware 

 Edit Acquisition 
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 Cycle Documentation 

 Setup View 

 Start Acquisition 

 New View 

 Edit View 

 Cursor 

 Mean Value (Stats) 

 Drift Compensation 

 Horizontal Grids 

 Vertical Grids 

 Zoom Out 

 Voltmeter 

 Oscilloscope 

 Cascade Views 

 Tile Vertical 

 Tile Horizontal 

 Help 

6.3.11 Status Bar 

The status bar can be enabled/disabled from the View → 
Status Bar menu selection. The status bar runs along the 
lower edge of the Dynoware screen. It is separated into 
two sections. The left side of the status bar offers 
information on a topic selected when the mouse is moved 
over a menu bar or tool bar item. The right section of the 
status bar and shows the status of the Caps Lock key, the 
Num lock key, and the Scroll lock key. 

 

Figure 6.20: Status Bar 

6.4 Analysis... 

6.4.1 Mean Value  

By selecting Analysis → Mean value from the main menu 
or by clicking the  

  
icon on the toolbar statistical data can be displayed on an 
active y(t) time based graph. 
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Figure 6.21: Mean value 

 
The statistical data will appear on the bottom of the graph 
(stats on up to 8 curves can be displayed). Statistical data 
will include: Maximum value, Minimum Value and Mean 
(average) value between two user identified points. 

 

 
Figure 6.1: Sample statistical data 

A dashed vertical bar will first appear on the graph along 
with the cursor. This vertical line will track the mouse 
movement to set the starting point for the analysis. Move 
to the desired starting position then left click the mouse. 
Next, a dashed vertical bar will appear on the graph along 

with the cursor. This vertical line will track the mouse 
movement to set the ending point for the analysis. Move 
to the desired ending position then left click the mouse. 
 
To change either the starting position or ending position 
and update the statistical data: 
1.) Move the mouse over the dashed vertical cursor line. 

The cursor will change to  
2.) Click the left mouse button and drag the line to a new 
position (cursor will change to when dragging) 
3.) Release the mouse, the statistical data will be updated. 
 
The Mean value analysis can be disabled and the graph 
restored to normal by reselecting the menu choice, or the 
toolbar icon. 

6.4.2 Signal Drift Compensation 

By selecting Analysis → Signal Drift Compensation from 
the main menu or by clicking the  
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icon on the toolbar, data can be adjusted to remove the 
effect of long-term thermal drift and offset. This is 
accomplished by computing a straight line between a 
starting and ending point, then subtracting this line from 
the selected portion of the data set. All data sets on the 
current time series graph will be compensated. 
This function is especially designed for resolving the 
problems of drift in piezoelectric measurement systems. In 
the Operate mode, the signal drifts away with a constant 
slope, however the direction (if negative or positive) is 
unpredictable. In short measurements or in measurements 
with high forces this drift is usually negligible. After very 
long measurements however this drift is clearly visible. The 
measurement is started before applying the force and 
continues until there is no force applied to the tool 
anymore, the drift is visible as the signal that does not fall 
back to the zero line. 
 

 
 

Note: 
The selection of the starting and ending points are 
critical to the accuracy of the compensation. 

 

 
 

Note: 
The words 'Drift Compensation On' will appear in the 
upper left corner the graph to identify the data set as 
modified. 

 
When selecting drift compensation: 
A dashed vertical bar will first appear on the graph along 
with the cursor. This vertical line will track the mouse 
movement to set the starting point for the compensation. 
Move to the desired starting position then left click the 
mouse.  
Next, a dashed vertical bar will appear on the graph along 
with the cursor. This vertical line will track the mouse 
movement to set the ending point for the compensation. 
Move to the desired ending position then left click the 
mouse. 
The first vertical line should be placed right before the 
rising edge of the force curve - where the signal still lies on 
the zero line. The second line has to be placed where there 
is no force application anymore, i.e. where the measured 
signal should lie again on the zero line. 
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Figure 6.22: Original Signal 
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Figure 6.23: Drift compensation applied 

 
To change either the starting position or ending position 
and update the compensation: 

1.) Move the mouse over the dashed vertical cursor line. 
The cursor will change to  

2.) Click the left mouse button and drag the line to a new 
position (cursor will change to when dragging) 

3.) Release the mouse, the data set will be updated and the 
graph redrawn. 
 
The change is only temporary and can be disabled by 
reselecting the menu choice, or the toolbar icon. Select 
Overwrite File Cycle Data (see Section 6.4.5) to per-
manently apply the changes to the data set. 



Reference 
 
 

002-195Ae-06.02 (B19.2825Ae)  Page 55 
 

6.4.3 Smoothing on… 
Smoothing is used to filter a data set or to remove defined 
frequency content. The type of filter to use depends upon 
the type of modification required. The filtering options are: 
Moving Mean, Moving Median, Digital Low Pass, and 
Digital High Pass. Each is discussed in the following 
paragraphs. Select the channels to apply the filter from the 
list presented or press the All Channels button to select all 
available channels. 

 

 
 

Note: 
The words 'Smoothing On' will appear in the upper left 
corner of the graph to identify the data set as modified. 

6.4.3.1 Moving Mean 

A moving mean filter is used to smooth an entire data set 
when no particular frequencies are to be filtered out. This 
type of filter generates a moving average data set from the 
original one, based on a user-specified Window size. The 
window size specifies how many values to the left and 
right of the current value are averaged. The window size 
must be an odd number, because the current value must 
fall in the exact center of the window, with an even 
number of points to the left and right of it (if you enter an 
even number, the calculation is made with the next higher 
number). The average of all values in the window is 
calculated, and this number is used to replace the current 
value. The larger the window size, the more the resulting 
data set is smoothed. The Figure below illustrates both the 
moving mean and the moving median filters. 
 

 
 

Note: 
At the beginning and the end when the window size 
would exceed the sampled values, the window size is 
reduced, starting and ending with a window size of 
CEIL(WindowSize/2). 
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Figure 6.24: Moving mean and moving median filters 

6.4.3.2 Moving Median 

The moving median filter is similar to the moving mean in 
that it also uses a moving window. However, this method 
sorts the values within the window and replaces the 
current value with the median value (i.e., the middle value 
in the sorted data window). The moving median type filter 
is good for removing sharp spikes in the data.  

6.4.3.3 Digital Low Pass 

For a low pass filter, the cutoff frequency is the frequency 
above which all frequencies are attenuated to some 
degree, and below which all frequencies pass unfiltered. 
Essentially, all low frequencies are allowed to pass, and all 
high frequencies are removed. The specified cutoff 
frequency is the −3db (half power) attenuation point of a 
13 tap Finite Impulse Response (FIR) filter. 

6.4.3.4 Digital High Pass 

For a high pass filter, the cutoff frequency is the frequency 
below which all frequencies are attenuated to some 
degree, and above which all frequencies pass unfiltered.  
Essentially, all high frequencies are allowed to pass, and all 
low frequencies are removed. The specified cutoff 
frequency is the −3db (half power) attenuation point of a 
13 tap Finite Impulse Response (FIR) filter. 
 
Smoothed data is not stored permanently and can be 
undone by selecting Analysis → Smoothing Off (Section 
6.4.4 Smoothing off) from the main menu. Select 
Overwrite File Cycle Data (see Section 6.4.5) to 
permanently apply the changes to the data. 
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Warning: 
Kistler measurement equipment is very sensitive. 
Sometimes what appears to be noise can be “real” 
measured phenomena. Care should be exercised in 
filtering so as not to remove important data. 

 
Below is an example of a "noisy" data set Figure 6.25: 
Original data set (no smoothing), on which a Moving 
Median filter (Windows Size = 13) has been applied, Figure 
6.26: Smoothing on, moving mean (window size = 13). 

 

Figure 6.25: Original data set (no smoothing) 

  

Figure 6.26: Smoothing on, moving mean (window size = 13) 

6.4.4 Smoothing off 

Selecting Analysis → Smoothing Off will disable any filters 
currently applied to the data set. A check mark on the 
menu will indicate if smoothing is currently on or off. 

6.4.5 Overwrite File Cycle Data 
The operations Smoothing and Signal Drift Compensation 
display temporary changes to a data set. These operations 
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do not permanently affect the data stored in a file. To 
permanently archive these changes, select Overwrite File 
Cycle Data from the Analysis menu. 
 
This operation allows the user to apply several different 
functions to a data set. For instance, data can be compen-
sated for drift; the changes save in the file, and then Mean 
value analysis can be done.  Normally the drift compen-
sation and mean value functions are mutually exclusive 
(cannot be done at the same time). 
 

 
 

Warning: 
Overwritten changes cannot be undone and 
permanently modifies the data in the file. Be sure to 
make a backup of the original file prior to selecting 
Overwrite File Cycle Data. 

6.5 Tools...  

6.5.1 Voltmeter… 
The Voltmeter (Figure 6.27: Voltmeter) is a trouble-
shooting tool that numerically displays the voltages at the 
inputs to the A/D board. Selecting Voltmeter from the Tool 
menu starts the meter. Any configured amplifiers are 
placed into operate mode automatically at the start of the 
voltmeter, and are returned to reset when the tool is 
exited. To stop the acquisition press the Stop button, to 
restart the acquisition press Run. 
 

 
Figure 6.27: Voltmeter 
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The grid shows the channels configured in the system, their 
active state, and the configured label. To enable/disable a 
channel use the On column check box. 
 
The voltage data can be selected to appear in Volts [V] or 
Millivolts [mV]. 
 
The Voltmeter can be run at the same time as the 
Oscilloscope function, but other data acquisition functions 
are disabled while the Voltmeter is active. 

6.5.2 Oscilloscope… 
The Oscilloscope (Figure 6.28: Oscilloscope Tool) is a 
troubleshooting tool that graphically displays the voltages 
at the inputs to the A/D board. Selecting Oscilloscope from 
the Tool menu starts the scope. Any configured amplifiers 
are placed into operate mode automatically at the start of 
the oscilloscope, and are returned to reset when the tool is 
exited. To stop the acquisition press the Stop button, to 
restart the acquisition press Run. 
 

 
Figure 6.28: Oscilloscope Tool 

 
The grid shows the channels configured in the system, their 
active state, and the configured label. To enable/disable a 
channel use the On column check box. The channel color is 
displayed in the On column. 
 
The voltage scale, and time scale can be selected from the 
Volt/Div. and Sec./Div. Boxes.  
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The Oscilloscope can be run at the same time as the 
Voltmeter function, but other data acquisition functions are 
disabled while the Oscilloscope is active. 

6.6 Options... 

6.6.1 User Mode 
The User Mode allows the software operation to be 
restricted. The default user mode is Supervisor. 

6.6.1.1 Supervisor 

No operation restrictions are made in the Supervisor mode. 
To restrict access to software and device configurations, 
select the operator mode. The default password is 
"DynoWare"  (capital 'D' and 'W', lower case for other 
letters!). 

6.6.1.2 Operator 

No functional settings can be made in this mode (Changes 
to devices configurations, etc. can only be made in the 
supervisor mode). To switch from User mode to Operator 
mode a password is required. 

6.6.1.3 Change Password 

 
Figure 6.29: Changing Password 

To change the Operator/Supervisor mode password select 
the Options → User Mode → Change Password menu 
choice. You will need to enter the old password, and enter 
the new password twice identically for the new password 
to be accepted. Passwords are case sensitive. The default 
password is "DynoWare" (capital 'D' and 'W', lower case 
for other letters!). 
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6.7 Window... 

When a graph is open, the Window menu appears in the 
menu bar. The Window menu is for controlling the position 
of the graphs, and is useful when many different graphs 
are open on the screen.  

6.7.1 Cascade 
Arrange all open graphs staggered and overlapping each 
other. 

6.7.2 Tile Horizontal 
Arrange all open graphs to be non-overlapping tiled 
horizontally. 

6.7.3 Tile Vertical 
Arrange all open graphs to be non-overlapping tiled 
vertically. 

6.7.4 Arrange Icons 
Arranges all minimized graphs icons in the lower left corner 
of the application. 

6.7.5 Close All 
Closes all open graphs and files. 

6.7.6 <open windows list> 
Shows a list of open graphs. Select an item in the list to 
active a specific graph. 

6.8 Help...  

6.8.1 Help Topics 
The Dynoware help menu is available by selecting Help 
Topics from the Help menu, or by pressing F1 at any time. 
Dynoware uses standard HTML help format through the 
default-configured browser (see section 1.1 for more in-
formation).  
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6.8.2 About Dynoware 
The Dynoware about box provides information about the 
running version of the application, the build number, and 
the product type number. Be prepared to provide this in-
formation when requesting technical support. 
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7. Appendix 

7.1 Graphs 

Manipulating data using graphs is simple and quick with 
Dynoware. When a trial is opened one or more graphs 
appear using the default configuration (see Section 6.3.3 
Setup…). The graphs can be edited for content, display, 
and titles. 
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Figure 7.1: Typical time based y(t) graph 

 
 

7.2 Language Selection 

Each supported language that is installed is available to the 
user by pressing Ctrl+Alt+S then selecting the language 

Graph information Area: 
Zoom , Smoothing, and Drift 
Compensation 

Zoom selection = right click 
and drag 
Zoom out = double right click 
 

Second y-Axis 

Legend, shows 
label, units, and 
axis 

Cycle move 
forward, cycle move 
backward buttons. 

Main Title (double click to 
edit) 

Current cycle number Vertical dashed bars for 
drift compensation, 
cursor, or mean value 
calculations. 

Graphical data 
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from the choices presented. The new language is loaded 
next time the application is started. 

7.3 Shortcut Key Summary 

Key Command 

F1 Help 
Alt+D View → Documentation 
Alt+E Acquisition → Edit 
Alt+H Acquisition → Hardware 
Alt+S Acquisition → Start 
  
Ctrl+Alt+S Select Language 
Ctrl+P  Print Report 
Ctrl+L Report Layout (not documented) 
  
Ctrl+TAB Cycle through Open Windows (forwards) 
Ctrl+SHIFT+TAB Cycle through Open Windows (backwards) 
  
Right Mouse Drag 
on graph 

Zoom In on graph 

Right Mouse 
Double Click on 
graph 

Zoom Out (if previously zoomed in) 

7.4 Modifying the Report Logo 

If you want to modify the report print-out to have your 
companies logo perform the following steps: 
 
1.) Use Notepad to Edit the "DynoWare_20.ini" file.   
Open  the file C:\Windows\dynoware_20.ini (for 
Windows 95 or Windows 98) or C:\Winnt\dyno-
ware_20.ini (for Windows NT or Windows 2000), 
respectively. 
 
2.) Add the logo image file to Dynoware. 
In the [dynoware_20] section, add (or edit) the 
logo={drive:\path\file} command to add the image 
file you to appear on the report.  In the example 
below, mylogo.bmp will appear on the report.  
 

Figure 7.2: Adding the report logo file 

Notes: 
The image file extension does not need to be entered.  
DynoWare will search for "bmp", "wmf", "pcx", "tif" and 
"jpg" image extensions automatically (and supports these 
types of images). The recommended image size is 362 
(width) by 67 (height) pixels. Images will be scaled to fit 
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and centered in the logo area of the report. The default 
logo "prnlogo.bmp" that appears in the DynoWare 
directory can be used as an example logo.  Copy the file 
and edit for the desired logo. 

7.5 Example Files 

Filename Description 

Bohren LW 13.dwd  
Messdat2.dwd  
Swept_sine.dwd 1 channel Swept sine wave for filter experimentation 
Frasen_15000rpm_2.dwd  
5A-Fraesen_Aussen_2.dwd  
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7.6 Index 

5 
5011 ............................................................34 
5015 ............................................................34 
5017 ............................................................30 
5019 ............................................................30 
5223 ............................................................36 
5237 ............................................................38 

A 
About...........................................................62 
Acquisition ...................................................28 

C 
Channels ......................................................40 
Charge amplifiers..........................................19 
Clipboard, Copy to........................................28 
Comments....................................................46 
Computer specifications ................................12 
Configuration ...............................................24 
Connecting the cables...................................18 
Cursor ..........................................................49 

D 
Data acquisition board ..................................14 
Data manipulation ........................................42 
Digital high pass ...........................................56 
Digital low pass.............................................56 
Documentation.............................................47 

E 
e-mail address ................................................6 
Exit ..............................................................28 
Export….......................................................24 

F 
File menu .....................................................23 

G 
Graph...........................................................63 
Grid..............................................................50 

H 
Hardware .....................................................28 
HASP key .....................................................14 
Help .....................................................5, 6, 10 
Help menu ...................................................61 

I 
Instacal.........................................................16 
Installation of A/D board...............................15 
Installing.......................................................13 

L 
Language .....................................................63 
License agreement ..........................................7 
Logo ............................................................64 

M 
M.U. ............................................................30 
Mean value ..................................................51 
Moving mean...............................................55 
Moving median ............................................56 
Multicomponent measurement......................31 

O 
Open ...........................................................23 
Operator ......................................................60 
Oscilloscope .................................................59 
Other amplifiers............................................35 
Overwrite file cycle data................................57 

P 
Password......................................................60 
PC-CARD-DAS16/16....................................15 
PCIM-DAS1602/16 ......................................15 
Print preview ................................................26 
Print setup ...................................................28 

Q 
Quick start ...................................................20 

S 
Shortcut key .................................................64 
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Signal drift compensation ..............................53 
Smoothing....................................................55 
Software installation......................................13 
Start .............................................................43 
Status bar .....................................................51 
superimposed ...............................................45 
Supervisor.....................................................60 

T 
Toolbar.........................................................50 
Tools menu...................................................58 
Trigger .........................................................40 

U 
User mode....................................................60 

V 
View edit......................................................45 
View setup ...................................................46 
Voltmeter .....................................................58 

W 
Warranty....................................................... 7 
Window menu..............................................61 

Z 
Zoom ...........................................................48 

 


